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The ___________________ pane in the Catalog dialog box lists different types of publications.
The Publications by ___________________ tab in the Catalog dialog box categorizes publications by their purpose.
Publisher lets you edit text using Microsoft Word by choosing ___________________ on the shortcut menu.
Publisher can import ___________________.
The mouse pointer changes to a(n) ___________________ when positioned on text boxes.
The Text Frame Properties dialog box includes options for ___________________.
Graphics can be ___________________.
If you resize a graphic, be sure to hold down the ___________________ key while dragging the corner sizing handle to maintain the graphic's proportionality.
Pressing ___________________ inserts a line break into a text frame.
Press ___________________ when you want a paragraph break between each line.
If you want the special characters for line and paragraph breaks to display on the screen, click the ____________________________ button on the Standard toolbar.
If you want to use lines simply to create borders or ruling lines above and below text, click the ___________________ button on the Formatting toolbar.
A WordArt object, created in a(n) ___________________, is actually a graphic and not text at all.
WordArt includes options for ___________________.
___________________ is Publisher's way of aligning objects created very close to other objects, guides, or boundaries.
A(n) ___________________ is a lightly shaded object displaying behind everything else on the page.
Which of the following is a logical choice for a text frame on a background?
If you want the background not to display on a given page, click ___________________ on the View menu.
The combination keystrokes of ___________________ will convert selected objects into transparent ones.
CTRL+T is a(n) ___________________, meaning that you can press it once to turn transparency on and again to turn transparency off.
The ___________________ looks for errors related to design issues and object interaction, providing comments and correction choices.
The Design Checker can check ___________________.
Some printers can perform ___________________ printing, which prints both sides before ejecting the paper.

True/False
____ Brochures, designed to be in circulation for longer periods of time as a type of advertising, usually are published in fewer quantities and on less expensive paper than newsletters are and are, therefore, less costly.
____ Brochures are a perfect forum for dated information.
____ A good newsletter, or any publication, must deliver a message in the clearest, most attractive, and effective way possible.
____ You can type a newsletter from scratch by choosing a blank publication from the Blank Publications tab, or you can use a wizard and let Publisher format the newsletter with the appropriate headings, graphics, and spacing.
____ You must make special arrangements to use the publications from the Publications Wizards tab or Design Wizards tab, so as not to violate Publisher's licensing agreement.
____ Options shown with the null symbol are not available in the selected wizard.
____ Publisher allows users to import text and graphics from many sources into its publications.
____ In order to import all manner of word processing documents into Publisher, you must have chosen to perform a full installation of Publisher.
____ To adjust the size of the characters on the screen, you can click the Magnification box arrow and then select the desired percentage or magnification style.
____ If a story you import into a text frame contains more text than will fit in the frame, Publisher will connect automatically to the adjacent frame.
____ In Publisher, you can create text in columns by either connecting separate, columnar text frames or using multiple columns within one text frame.
____ If you want separate stories in adjacent columns, you should use separate text frames.
____ Publisher will import plain text files, files from the popular text editing and word processing programs, and HTML files as text.
____ Publisher permits you to store nine unique sets of personal information for use at work or home.
____ You permanently can change personal information components, or change them temporarily one publication at a time.
____ Every new publication has the Home/Family personal information set selected by default.
____ Activated from the Tools menu, the Connect Frame toolbar floats in the workspace or can be dragged to the toolbar area.
____ All columns within a single text frame are the same width.
____ Stories across pages do not require separate text frames.
____ Graphics are limited to images and pictures.
____ Rather than searching through many graphics for just the right picture, you can type in a keyword in the Insert Clip Art dialog box and Publisher will display only the graphics related to those keywords.
____ A table of contents always is necessary, even if a newsletter only has two pages.
____ If your clip art is limited, the graphics toward the top of the preview panes usually are included as part of the installation on your hard disk.
____ The opposite graphic orientation of portrait is horizon.
____ Text automatically wraps around graphics in the Newsletter Wizard.
____ When you change graphics inserted near a text frame that uses columns, your choice may alter both the way the columns in the text frame look, as well as where the columns break.
____ Shift-dragging maintains a graphic's proportional height and width.
____ Graphics and mastheads are good multiple entry devices, offering readers many ways to digest a newsletter article.
____ Layout specialists say that the title of an article and its pull quote(s) should outline the intended message of the article.
____ Sidebars should not be placed close to their related text so as not to distract from the main article.
____ To format a line, right-click it and then click Change Line on the shortcut menu.
____ Lines are used in newsletters only to separate groups of objects, either to give the reader a visual break from text only, or to separate ideas or content.
____ Publisher uses the combination of CTRL and drag to create a perfectly straight line, horizontally or vertically.
____ A WordArt object, created in a frame, actually is text and not a graphic at all.
____ If you misspell the contents of a WordArt object and then spell check the publication, Publisher will catch the misspelled word(s) just like in any other text frame.
____ WordArt uses its own toolbar to add effects to WordArt graphics.
____ The background is a blank sheet located behind your publication where you place objects that will display on every page, such as headers and footers, page numbers, and logos.
____ Most publication objects, like text and graphics, actually lie in front of the background, allowing the format to display from behind.
____ A text frame, created by clicking a button on the Objects toolbar and then drawing a rectangle, keeps text together so it is easier to move and edit.
____ Text frames for page numbers and headers/footers are the only objects that appear in the background.
____ You can add additional formatting, such as borders, alignment, and text rotation, to an entire text frame, once the text frame has been set up.
____ Options on the Date/Time menu allow you to insert dates and times derived from the operating system that will update automatically when the publication is edited or printed.
____ If text has been checked for spelling before it is imported, Publisher will not recheck it after importing it.
____ If you resized any graphic in your publication, Publisher's Design Checker will warn you that the graphic may not be correct proportionally.
____ Printing the pages of a newsletter double-sided is a process that is highly dependent upon the printer.

Short Answer
A(n) ______________________ is usually a multi-page publication, double-sided, with newspaper features like columns and a masthead, and the added eye appeal of sidebars, pictures, and other graphics.
Publisher's _______________________ is a visual directory of publication designs.
The _______________________ pane in the Catalog dialog box displays the publication layouts available.
The Publications by _______________________ tab in the Catalog dialog box displays design sets.
A(n) _______________________ is a collection of related publication types that share a consistent design or look.
The Blank _______________________ tab in the Catalog dialog box displays previews of formats, rather than a complete template or wizard.
The _______________________ button in the Catalog dialog box provides access to previously saved publications.
The _______________________ button in the Catalog dialog box provides access to saved or downloaded templates.
The term _______________________ means any preset feature of data provided as part of the initial setup.
Any publication you choose from the Publications Wizard tab or the Design Wizards tab is a(n) _______________________-designed Publication.
A(n) _______________________ is a box or section printed in each issue displaying information like the name, publisher, location, volume, and date.
The _______________________ key deletes text to the left of the insertion point.
To select large amounts of text, click the text and press _______________________.
_______________________ means moving data or programs from a larger computer system to a smaller one.
Publisher uses the term _______________________ to describe inserting text or objects from any other source into the Publisher workspace.
Connecting the running text from one column to the next in a multi-column text format is known as _______________________ the text.
When you connect a story from one page to another, Publisher will add the continued notices, or _______________________ lines, to guide readers through the story.
The _______________________ function key toggles between the current page view and Actual Size view.
The name of the organization, the address, the telephone number, and other pieces of information like tag lines and logos are stored in _______________________ sets.
A personal information _______________________ is a text frame that contains information about the organization from the personal information set.
If you want to keep Publisher from _______________________, or repeating, the contents of a changed personal information component on subsequent pages, you can click Undo on the Edit menu.
_______________________ are eye-catching graphics and text that draw attention to a location on the page.
A(n) _______________________, an organization's signature symbol, is a personal information component that varies with each personal information set.
A(n) _______________________ is a small piece of text, set off with a box or graphic, and placed beside an article.
A(n) _______________________ is an excerpt from a main article used to highlight the ideas or to attract readers.
The clip art provided with Publisher has assigned _______________________ to make finding clips easier.
Some of the images and clip art in Publisher are _______________________ oriented, which means they are taller than they are wide.
Graphics in the Clip Gallery are _______________________, which means the height and width have been set in relation to each other, so as not to distort the picture.
_______________________ quotes are especially useful for breaking the monotony of long columns of text.
The Copy button copies objects from the publication to the _______________________.
You use a(n) _______________________ break when you have short lines or want to advance the insertion point to a new line without new paragraph formatting.
Press ENTER when you want a(n) _______________________ break between each line.
Publisher uses a combination of the _______________________ key and dragging to create perfectly straight lines, horizontally or vertically.
When a text frame becomes _______________________, this does not mean that it becomes invisible; rather, any object behind the frame will show through.
Typically, items in the _______________________, or in the front, which partially cover an item in the background, need to be transparent.

